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Abstract 
From liver diseases, nonalcoholic steatohepatitis (NASH) is a disease that affects 5.3% of the people 
in the world. Patients with NASH have inflammation in the liver which is also known as fibrosis which 
can be chronic and lead to the development of hepatic cirrhosis. To treat patients with fibrosis, 
studies are ongoing to develop antifibrotic therapies to inhibit fibrosis. In these studies, the focus is 
on developing autotaxin inhibitors to reduce fibrosis. The enzyme autotaxin plays an important role 
in the production of LPA which is an extracellular signaling molecule. LPA can bind as an extracellular 
molecule to LPA1-3 receptors while LPA4-6 receptors preferably be activated by LPA with the guidance 
of ATX. Since the LPA receptors are involved in fibrosis, it is desirable to investigate the difference 
between these receptors in hepatic fibrosis using human hepatic stellate cells (HSCs) cell line LX-2 
with knock-out of LPA receptors. To create this knock-out cell line, an optimized Nucleofection® 
protocol is needed to transfect the LX-2 cells with CRISPR/Cas9. Here the Nucleofector® programs 
EW-113 and CA-137 are compared to each other based on transfection efficiency and cell viability. 
For Nucleofection® experiment 150.000 cells were needed. To get the least cell loss after 
centrifugation, different centrifuge programs (90xg for 10 min, 240xg for 3 min, and 300xg for 5 min) 
were investigated. From the results of experiments, there were no significant differences between 
centrifuge programs in terms of least cell loss after centrifuge. From the results of transfection 
efficiency and cell viability, the program CA-137 is the most suitable program to have the highest cell 
viability combined with sufficient high transfection efficiency for Nucleofection® of LX-2 cells with 
CRISPR/Cas9. 

1. Introduction 
Nonalcoholic fatty liver disease (NAFLD) is a liver disease whereby patients have an accumulation of 

fat in the liver which is more than 5% of the liver weight [1],[2]. This accumulation is also known as 

hepatic steatosis [1]. In contrast to other liver diseases such as alcoholic fatty liver disease (AFLD), 

patients with NAFLD don’t consume excessive alcohol, do not have any drug treatments, and don’t 

have viral infections like viral hepatitis [1],[2],[3],[4].  

NAFLD affects roughly 1 billion people in the world [3]. A part of the population with NAFLD is also 

diagnosed with a progressive form of NAFLD namely nonalcoholic steatohepatitis (NASH) [1],[3],[4]. 

This progressive disease has a global prevalence of 5.3% [4]. Patients with NASH have inflammation in 

their liver in opposite to patients with NAFLD [3]. Due to the inflammation of the liver, fibrosis will be 

active which repairs the damaged liver tissue by replacing it with fibrous connective tissue so scar 

tissue will be formed. When the process of fibrosis is chronic, it can lead to the development of 

hepatic cirrhosis [3]. This means that the normal liver function of this tissue is impaired. Hepatic 

cirrhosis is an end-stage liver disease that is life-threatening [5]. Furthermore, patients with NASH can 

develop hepatocellular carcinoma [1],[3],[4].  

To develop new antifibrotic therapies for patients with NASH, researchers investigate human hepatic 

stellate cells (HSCs), because these cells are involved in the process of fibrosis in patients with NASH 

[6],[7]. When the liver is injured, the hepatic stellate cells will be activated to transdifferentiate into 

myofibroblast-like cells which activate fibrosis [6],[7],[8]. Whereby the most suitable HSC cell line is 

LX-2 because these cells are viable in serum-free media and the transfectability of these cells is high 

which is useful for research [8]. Moreover, these cells are immortalized which is also an advantage for 

culturing them [8]. 

Several studies are going on to investigate the different pathways to fibrosis in NASH. By 

understanding these pathways, new therapies can be developed and investigated to treat patients 

with NASH. One of the studies of M. ten Hove is about the effectiveness of two different autotaxin 

(ATX) inhibitors on hepatic fibrosis in the NASH mice model. 
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Autotaxin is an enzyme that converts lysophosphatidylcholine (LPC) to form lysophosphatidic acid 

(LPA), see Figure 1 [9]. LPA is an extracellular signaling molecule that activates G-protein-coupled 

receptors (GPCRs) [9],[10]. There are six types of LPA receptors: LPA1, LPA2, LPA3, LPA4, LPA5 and LPA6 

receptors see Figure 1 [9],[10]. The LPA1-3 receptors belong to the Edg family while the LPA4-6 

receptors belong to the non-Edg family, also known as the P2Y family, see Figure 1 [9]. 

 

Figure 1: Overview of LPA production by ATX and the binding modes of LPA to two different groups of LPA receptors. LPA1-3 
belongs to the Edg family and can be activated by extracellular LPA signaling molecules. The non-Edg family are the LPA4-6 
receptors which can be activated by LPA lateral diffused molecules [9]. 

The LPA receptors control different pathways of cell activities like proliferation and differentiation 

[11]. LPA signaling molecules are involved in fibrosis and are also involved in the development of 

tumors [10]. Additionally, ATX also plays a role in fibrosis due to its function as an enzyme for the 

production of LPA [10]. A study demonstrated that when the enzymatic function of ATX  is inhibited, it 

leads to less fibrosis in the liver [10],[12]. Therefore ATX has an antifibrotic effect when it is inhibited 

[12]. This antifibrotic function of ATX by inhibition is being investigated by M. ten Hove in NASH 

mouse models to find an ATX inhibitor to inhibit the development of hepatic fibrosis. 

There are several types of ATX inhibitors (see Figure 2): type I, type II, type III, type IV, and type V 

[9],[11]. In the research of M. ten Hove, the focus lies on type I and type IV ATX inhibitors. There are 

three different sites on ATX enzymes [9]. One site is the hydrophobic channel (or hydrophobic tunnel) 

of ATX where steroids and LPA can bind to modulate the enzyme [9], see Figure 2. Another site is the 

hydrophobic pocket where LPC and LPA can bind, and a third place is where two Zn2+ ions are located 

which are part of the catalytic mechanism of this enzyme, see Figure 2 [11]. 
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Figure 2: Different types of ATX inhibitors are shown with their binding sites at ATX in orange [11]. Also, the three different 
binding sites are named in the first image of ATX with inhibitor Type I: hydrophobic channel, hydrophobic pocket , and active 
site where two Zn2+ are located for the catalytic function of ATX. [11]. 

The type I inhibitor blocks the hydrophobic pocket and the catalytic site of ATX so these sites are 

blocked in the catalytic mechanism so LPA can’t be produced, but the hydrophobic channel is still 

functional to transport LPA to the receptor, see Figure 2 and Figure 3 [11]. The type IV ATX inhibitor 

also blocks the hydrophobic pocket but besides of hydrophobic pocket, it blocks the hydrophobic 

channel instead of the catalytic site of ATX, see Figure 2 and Figure 3 [11]. In this case, the production 

of LPA is blocked and transport of LPA to the receptor is also not possible due blocked hydrophobic 

channel, see Figure 3. 

 

Figure 3: Overview of functions of the enzyme ATX: LPC conversion into LPA and ATX binding with LPA to form ATX-LPA. ATX 
inhibitor type I inhibits only the production of LPA while ATX inhibitor type IV inhibits the production of LPA and also inhi bits 
the possibility for ATX to bind with an extracellular LPA to form an ATX-LPA complex [13].  

From the results of research (see Figure 4) by M. ten Hove, there was a difference in the effectiveness 

of two different ATX inhibitors on the NASH mouse model. One of the ATX inhibitors (type IV), led to 

less activation of alpha-smooth muscle actin (α-SMA), which is a biomarker for hepatic fibrosis [14], 

and less secretion of collagen-I in contrast to the other ATX inhibitor (type I), see Figure 4. The mouse 

with ATX inhibitor Type I and the mouse which has received only vehicles, both showed comparable 

activation of collagen-I and α-SMA, see Figure 4. In the literature, (Salgado-Polo et al., 2023) 

mentioned the difference in the effectiveness of inhibition of ATX between type I and type IV ATX 

inhibitors on fibrosis [13]. Type IV inhibitor prevents the activation of both receptors LPAR1 and 

LPAR6. While type I inhibitor only prevents activation of LPAR1 therefore LPAR6 still can be activated. 

Because LPAR1 can be activated by extracellular LPA, while LPAR6 is preferably activated by LPA from 

the lipid bilayer by the guidance of ATX [13]. So ATX type IV inhibitor blocks the hydrophobic channel 
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which means the guidance of LPA to LPAR6 is not possible [13]. Both, type I and type IV block the 

production of LPA so there will be less LPA left in extracellular space to bind at LPAR1. There is still LPA 

left in extracellular space because LPA can also be produced by phospholipase A enzymes which 

convert phosphatidic acid into LPA, but in a lesser amount than it is produced by ATX [15]. 

 

Figure 4: A: Collagen-I staining and alpha-smooth muscle actin (α-SMA) of liver tissue from four mice. Whereby the healthy 
mouse is taken as control. The other three mice have had a combination of Western Diet (WD) and carbon tetrachloride 
(CCl4) to induce NASH. Whereby of these mice has received the ATX Type I inhibitor and another mouse has received the ATX 
Type IV inhibitor. The other mouse of three, received vehicles instead of ATX inhibitor. B: The stained area of Collagen-I and α-
SMA of four mice with different treatments. This figure is used with the permission of M. ten Hove.  

To investigate the influence of the receptors of LPAR1 and LPAR6 on hepatic fibrosis, we want to be 

able to create human HSC cell line LX-2 with one group with a knock-out of LPAR1, the second group 

with knock-out of LPAR6 and the last group with knock-out of LPAR1 and LPAR6. To make this 

research possible, a protocol needed to be developed utilizing CRISPR/Cas9 to create a knock-out of 

the LPAR receptors in the human HSC cell line LX-2. 

CRISPR stands for Clustered Regularly Interspaced Short Palindromic Repeats which is a part of the 

bacterial immune system to defend against foreign viruses [16],[17]. CRISPR is a short repeating 

sequence in the DNA of bacteria [17]. CRISPR contains a spacer sequence of a target gene [17]. 

CRISPR works together with a protein called Cas9 [17]. This is an endonuclease that binds to DNA and 

can cut at the target sequence when it matches with the single guided RNA (sgRNA). The single 

guided RNA is an artificially designed sequence of target gene [17]. This consists of a crRNA and 

tracrRNA which are together a complex RNA [18]. When the sgRNA matches with the target sequence 

in DNA, Cas9 will cleave the DNA at this location and create a double-strand break. There are two 

methods of repair: non-homologous end joining (NHEJ) and homology-directed repair (HDR) 

[17],[18]. With NHEJ repair, Cas9 can randomly insert or delete a nucleotide to create a knock-out 

[17],[18]. With HDR the Cas9 can repair the target sequence with a template to create a knock-in 

[17],[18].  
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CRISPR/Cas9 will be used to make a knock-out because with this technique we can make a permanent 

knock-out of the LPAR1 receptor gene in comparison with for example small interference RNA (siRNA) 

method. With siRNA, the target mRNA sequences are knocked down by interference while with 

CRISPR/Cas9 the target gene is knocked out which means there is no chance of production of LPAR1 

receptors [19]. Furthermore, the cells that have knocked out genes by CRISPR/Cas9 will pass the DNA 

with mutation to their daughter cells in contrast to siRNA technology. With siRNA, only the 

transfected cells will have knocked down the target mRNA sequence.  

To bring CRISPR/Cas9 into the LX-2 cells, a transfection method will be used. Transfection is a process 

of bringing one of the molecules such as DNA, RNA, or protein, into the cell to change the genotype 

or phenotype of the cell. The Nucleofector is a device that works with an optimized electroporation 

technique as a transfection method [20]. Electric pulses will be sent to the cell membrane to create 

pores so the molecules can pass through the membranes by electrical field. With Nucleofector it is 

also possible to get molecules directly inside the nucleus [20]. This transfection method is also called 

Nucleofection® [20].  

The protocol for transfection of LX-2 cells with CRISPR/Cas9 with a Nucleofector® will be developed in 

steps. One of the steps is a transfection of a plasmid with reporter gene Green Fluorescent Protein 

(GFP) into human HSC cell line LX-2 with a Nucleofector®. Before the transfection experiment, three 

different centrifuge programs will be investigated to find an optimized centrifuge configuration to get 

at least as possible cell loss to get enough cells for the transfection experiment. 

Centrifuge configurations 

For Nucleofection® of LX-2 cells, there are 150.000 cells needed per condition. The conditions with 

150.000 cells, will be centrifuged. After centrifuging, the supernatant will be removed and the 

Nucleofection® Solution for Nucleofection® will be added to the cell pellet. For centrifuging of the 

cells, there are three configurations possible: 

Centrifuge program 1: 90xg for 10 minutes. This is recommended by Lonza in protocol to optimize 

Nucleofection® for cell lines [21],[22]. 

Centrifuge program 2: 240xg for 3 minutes. This configuration is used in the protocol for culturing  

human pluripotent stem cells [23]. 

Centrifuge program 3: 300xg for 5 minutes. This is used in the general protocol (Sigma-Aldrich) for 

LX-2 cells to get cell pellets [24].  

The centrifugation configurations are set with Relative Centrifugal Force (RCF) and the duration of the 

centrifugation in minutes.  

The centrifugation of cell suspension is needed to separate the cells from the medium. The medium 

(supernatant) will be extracted and a pellet of cells will remain in the tubes. For Nucleofection® of LX-

2 cells, the Nucleofection® Solution will be added after removing the supernatant from the cells. For 

centrifuging the cell suspension, there are different settings possible. Two parameters can be set: RCF 

value and time in minutes. The value of RCF and duration of centrifuging of cell suspension do have 

an influence on the rate of sedimentation of cells [25]. With a higher RCF value, more sedimentation 

of cells will occur. Also, by increasing the centrifugation time there will sediment more cells. So in 

general: the more cells sediments, the fewer cells are left in the supernatant which means the 

amount of cell loss will be low after removing the supernatant.  

For program 3 (300xg for 5 min) the time and RCF value are higher than program 2 (240xg for 3 min). 

Program 1 (90xg for 10 min) has the longest centrifugation time of all programs but program 3 has a 
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three times higher RCF value than program 1 while the centrifugation time is two times shorter than 

program 1. So we expect that program 3 (300xg for 5 minutes) has the least cell loss compared to the 

other two programs. 

To find the suitable centrifuge program for the experiment to transfect the LX-2 cells, we want to 

investigate the difference in the amount of cell loss after centrifuging at three different programs to 

find out which program is the best choice to get at least as possible cell loss to ensure having 150.000 

cells for each sample for Nucleofection® experiment. 

Pulse code programs of Nucleofector® 

There are several pulse code programs available on the Nucleofector® for Nucleofection® of cells. 

These programs contain configured settings for the electroporation with the Nucleofector®. 

Depending on which pulse code program, it can increase viability while decreasing transfection 

efficiency and vice versa. To choose the right pulse code program, it is needed to start with a program 

that has a balance between cell viability and transfection efficiency. From this starting point, it is 

possible to change from pulse code to increase the transfection efficiency or cell viability when it is 

needed. To optimize the Nucleofection® protocol for LX-2 cells, two different pulse code programs will 

be tested which have a balance between transfection efficiency and cell viability: EW-113 and CA-137. 

The pulse code program EW-113 was recommended by Lonza and CA-137 was used in a research 

(Paavola et al., 2021), to transfect LX-2 cells with CRISPR/Cas9 to create a knock-out of fibronectin in 

LX-2 cells [26]. To find the most suitable program, transfection efficiency, and cell viability will be 

determined after Nucleofection® of the LX-2 cells by different pulse code programs. 

To measure the transfection efficiency and to see whether the transfection is successful, a  vector with 

a gene of green fluorescent protein (GFP) will be used as positive control. When the GFP plasmid is 

inside the nucleus of the cell, the GFP gene will be expressed. The produced GFP proteins are 

fluorescent which can be detected by an inverted microscope. 

When the transfection of cells with GFP plasmid is successful, it is expected to detect green 

fluorescent signals in the cytoplasm of the cells with an inverted microscope after 24 hours of the 

Nucleofection® experiment. 

So when there are green fluorescent signals visible after Nucleofection® of LX-2 cells with GFP 

plasmid with both pulse code programs (EW-113 and CA-137) then we can make a comparison of 

transfection efficiency between these two programs. 

To determine the cell viability of LX-2 cells after Nucleofection®, the images of wells with LX-2 cells 

will be assessed on cell confluence over time. Also, the Alamar Blue assay will be used to determine 

the cell viability of the cells. Alamar Blue assay is a non-toxic method to determine cell viability and 

cytotoxicity [27]. Alamar Blue contains resazurin which is a blue non-fluorescence substance. The 

living cells will reduce the resazurin into resorufin, which is a pink fluorescent substance [27]. The 

intensity of fluorescence signals of resorufin can be measured with spectrophotometry with an 

excitation wavelength of 530 to 560 nm and an emission wavelength of 590 nm [27]. In a research 

(Lesueur et al., 2016) the influence of different sizes of plasmids on transfection efficiency and toxicity 

of adipose tissue-derived mesenchymal stem cells (AT-MSCs) with electroporation were investigated 

[28]. Here it is shown that plasmids are toxic to the cells after electroporation [28]. So, it is expected 

that after Nucleofection® the cell viability of LX-2 cells with GFP plasmid will be lower than after 

Nucleofection® of LX-2 cells without GFP plasmid. 
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2. Materials and Methods 

2.1 Cell culture LX-2 
 

Culture medium for LX-2 cells is made of Dulbecco’s Modified Eagle’s Medium (DMEM)  with 

GlutaMAX™ (Thermo Fisher Scientific Inc.) with 10% (v/v) Fetal Bovine Serum (FBS) (Sigma-Aldrich) 

and 1% (v/v) Penicillin/Streptomycin (pen/strep) (Capricorn Scientific GmbH). 

For passaging the LX-2 cells to new flasks, Phosphate Buffered Saline (PBS) (Sigma-Aldrich) is used to 

wash the cells and 0.05% Trypsin/EDTA (Thermo Fisher Scientific Inc.) is used to detach the cells from 

the surface of the flasks. See Appendix 7.1 for more details on the protocol to culture the LX-2 cells. 

 

2.2 Optimization of centrifuge configuration 
For the Nucleofection® protocol, three different centrifuge configurations were tested: 

Program 1: 90xg for 10 minutes. 

Program 2: 240xg for 3 minutes. 

Program 3: 300xg for 5 minutes. 

The LX-2 cells were washed with PBS and detached from the flask with the use of Trypsin/EDTA. The 

cells were counted by LUNA-II™ Automated Cell Counter. After counting cells, 60.000 cells were 

transferred to each 15 ml tube (Greiner Bio-One) for the centrifuge program. It was done in duplicate 

for each centrifuge configuration. Before centrifugation of the tubes, the cells were counted again of 

each tube. After centrifuging the cells with the Hettich Zentrifugen Universal 32 centrifuge, the 

supernatant was removed by aspiration system, and culture medium was added. Then a part of cell 

suspension volume was taken again from each tube of each centrifuge program to count the number 

of cells per ml by LUNA-II™ Automated Cell Counter. The total number of cells per tube was 

calculated before and after centrifuging. The percentage deviation of the number of cells per tube 

with respect to before centrifuge was individually calculated with Equation 1. The average deviation 

(%) was calculated for each centrifuge program. After this, the data of each centrifuge program were 

compared to each other with a Student’s t-test. were analyzed with a Student’s t-test. for comparison 

between centrifuge programs. See Appendix 7.2 for more details of the protocol. 

Equation 1: 

𝐷𝑒𝑣𝑖𝑎𝑡𝑖𝑜𝑛 (%) =
(# 𝑐𝑒𝑙𝑙𝑠 𝑎𝑓𝑡𝑒𝑟 𝑐𝑒𝑛𝑡𝑟𝑖𝑓𝑢𝑔𝑒 −  # 𝑐𝑒𝑙𝑙𝑠 𝑏𝑒𝑓𝑜𝑟𝑒 𝑐𝑒𝑛𝑡𝑟𝑖𝑓𝑢𝑔𝑒)

# 𝑐𝑒𝑙𝑙𝑠 𝑏𝑒𝑓𝑜𝑟𝑒 𝑐𝑒𝑛𝑡𝑟𝑖𝑓𝑢𝑔𝑒
∗ 100 

 

2.3 Nucleofection® of LX-2 cells with pmaxGFP™ vector 

The Nucleofection® experiment was done with a 4D-Nucleofector® Core Unit in combination with a 

4D-Nucleofector® X Unit, both from Lonza. For this experiment, the SE Cell Line 4D-Nucleofector™ X 

Kit S was purchased from Lonza. This kit included pmaxGFP™ vector, Nucleofector® Solution, and 

Nucleofector® Supplement 1. 

The performed preparations for the Nucleofection® experiment 

Before Nucleofection® of LX2-cells with pmaxGFP™ vector, LX-2 cells were cultured in T-75 flask. The 

optimal confluence for Nucleofection® is between 70% and 85%. For the Nucleofection® experiment, 
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150.000 cells per sample were needed. The needed volume of cell suspension was transferred to the 

master tube to have enough cells for the desired number of samples for the Nucleofection® 

experiment. 

The Nucleofector® Solution was prepared with SE Cell Line Nucleofector® Solution and Nucleofector® 

Supplement 1 at the ratio of 4.5 : 1. The stock solution of pmaxGFP™ vector was diluted with MilliQ 

to a concentration of 0.4 µg/µl as a working solution. Also, LX-2 culture medium (DMEM + 10% FBS + 

1% pen/strep + L-Glutamax) and Roswell Park Memorial Institute (RPMI) 1640 medium (Thermo 

Fisher Scientific Inc.) with supplements (10% FBS, 1% L-glutamine and 1% pen/strep) were prepared. 

In Table 1 the used volumes of Nucleofector® Solution, pmaxGFP™ vector, and LX-2 cells with 

Nucleofector® solution for each sample are given. The total volume of each sample was 20 µl. Also, 

the corresponding pulse code program for each sample is given in Table 1. 

Table 1: The amount of Nucleofector® Solution and pmaxGFP™ vector solution added to each sample and volume of LX-2 
cells with Nucleofector® solution added to each sample. And the corresponding pulse code program per sample. 

Nucleofector® 
Solution 

pmaxGFP™ vector (0.4 
µg/µl) 

LX-2 cells with 
Nucleofector® Solution 

Pulse code program 

13 µl 2 µl 5 µl EW-113 

13 µl 2 µl 5 µl CA-137 

15 µl - 5 µl EW-113 

15 µl - 5 µl CA-137 

15 µl - 5 µl Not in Nucleofector® 

 

The cell suspension was centrifuged at 300xg for 5 minutes. After removing the supernatant, 

Nucleofector® Solution was added to the cell pellet and resuspended well. Five tubes (Eppendorf) 

were prepared with the corresponding volume of Nucleofector® Solution and pmaxGFP™ vector, see 

Table 1. Thereafter, 5 µl of LX-2 cells with Nucleofector® Solution was added to each tube, see Table 

1. The total reaction volume of each sample was 20 µl. See Appendix 7.3 for more details of the 

Nucleofection® protocol. 

Nucleofection® experiment 

For the Nucleofection® experiment, four samples were transferred into four wells of 16-well 

Nucleocuvette™ Strip (Lonza). One sample without the pmaxGFP™ vector was left at room 

temperature outside of Nucleofector®. The 16-well Nucleocuvette™ Strip was inserted into the 4D-

Nucleofector™ X Unit. Two samples were electroporated with pulse code EW-113 and another two 

samples were electroporated with pulse code CA-137. See Table 1 for an overview of used pulse code 

programs for each sample. 

After Nucleofection® of the samples, they were incubated outside of Nucleofector for 10 minutes at 

room temperature. After incubation, 80 µl RPMI 1640 medium with supplements was added to each 

sample on Nucleocuvette™ Strip and to tube nr. 5 which was left outside Nucleofector® (see Table 1 

and were resuspended well. Each sample was transferred from the Nucleocuvette™ Strip to the new 

tubes and the wells were washed again with RPMI medium with supplement and again taken from 

the strip into the corresponding tubes. Also, the sample of tube nr. 5 had the same treatment as the 

samples from the strip. After all, each sample was divided into three wells of the prepared tissue 

treated 24-well plate (Avantor) with culture medium. This plate was placed in a humidified 37°C/ 5% 

CO2 incubator for later analysis. After 24 hours, the culture medium of the wells was replaced by a 
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new culture medium and thereafter it was replaced two times a week. See Appendix 7.3 for more 

details of the Nucleofection® protocol. 

Analysis with an inverted fluorescence microscope 

The 24-well plate with LX-2 cells was analyzed 24, 48, 120, and 168 hours after Nucleofection® with 

Inverted Microscope Ti-E from Nikon. 

The protein pmaxGFP™ has a wavelength excitation at 482 nm and emission at 502 nm. For the 

detection of fluorescence signals of this expressed protein, the filter block FITC is used. 

The images were made of all wells with magnification objectives of 4x and 40x with FITC filter block 

and also at the bright field with ‘RFLTC’ mode of Inverted Microscope Ti-E. 

See Appendix 7.3 for more details of the Nucleofection® protocol. 

2.3.1 Transfection efficiency 

For assessment of the transfection efficiency of different pulse code programs from Nucleofector® on 

transfection of LX-2 cells with pmaxGFP™ vector, software ImageJ was used to create overlays of 

brightfield images with images where green fluorescence signals were visible. Thereafter, the overlays 

of 4x magnification were used to determine the ratio of transfected cells to non-transfected cells. Cell 

counting was done by hand with the use of ImageJ software. There were more than 500 cells visible 

in images which would have cost a lot of time to count them by hand with ImageJ software. So the 

zoom function of ImageJ was used to zoom at 150% at the images and the area was selected which 

was the most representative for the rest of the image. Then the number of transfected cells and the 

number of non-transfected cells were counted with ImageJ. The transfection efficiency was calculated 

with Equation 1. 

Equation 1: 

𝑇𝑟𝑎𝑛𝑠𝑓𝑒𝑐𝑡𝑖𝑜𝑛 𝑒𝑓𝑓𝑖𝑐𝑖𝑒𝑛𝑐𝑦 (%) =
𝑛𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑡𝑟𝑎𝑛𝑠𝑓𝑒𝑐𝑡𝑒𝑑 𝑐𝑒𝑙𝑙𝑠

𝑡𝑜𝑡𝑎𝑙 𝑛𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑐𝑒𝑙𝑙𝑠
∗ 100 

2.3.2 Cell confluence 

To assess the confluence of all wells of conditions, the ImageJ software was used to measure the 

confluence of the wells. In ImageJ, all images were first changed from type 16-bit to 8-bit. After this, 

the variance was set to 3 pixels. Thereafter from every assessment session, one image of the same 

well from the control condition (no nucleofection) was used to set a threshold. The Ostu algorithm 

was set first, and then the minimum threshold of 25 and maximum threshold of 255 were set. After 

that, the holes were filled and the area was calculated with ‘Analyze Particles’. The ‘Analyze Particles’ 

only calculated the areas with a minimum of 50 pixels2 to detect the most cells. See Appendix  7.4 for 

more details of the protocol. 

2.3.3 Cell metabolic activity 

For assessment of the cell metabolic activity of LX-2 cells, the Alamar Blue assay was done 168 hours 

after Nucleofection®. Alamar Blue medium was made of 10% Alamar Blue stock solution with culture 

medium (DMEM + 10% FBS + 1% pen/strep + L-Glutamax). One well of each condition of the 24-well 

plate with LX-2 cells was washed with PBS and thereafter Alamar Blue medium was added to each 

well and also to one empty well. The 24-well plate was incubated for 7 hours in the humidified 37°C/ 

5% CO2 incubator. After incubation, from each condition, the medium was divided into two wells of a 

96-well plate for fluorescence measurement. The fluorescence intensity of resorufin in wells of 24-

wells plate was measured by PerkinElmer Victor X3 plate reader with filters which has an excitation 



11 
 

wavelength of 555/38 nm and the other filter has an emission wavelength of 600/10 nm. See 

Appendix 7.5 for more information on the protocol for the Alamar Blue assay. 

2.4 Statistical analysis of data 
The data were analyzed in Microsoft Excel with the use of Student’s t-test to find differences between 

the groups. When the Student’s t-test showed p < 0.05 then there was a significant difference 

between the groups. 

3. Results 

3.1 Centrifuge configurations 
The goal of this experiment was to find a centrifuge configuration with the least cell loss. For this, the 

results of the average deviation of the number of LX-2 cells after spinning down each centrifuge 

program were compared to each other. 

 

  

Figure 5: The percentage average deviation of the number of LX-2 cells after centrifuge at different centrifuge programs with 
respect to before centrifugation. Here it is shown that the average deviation of program 1 (90xg for 10 min) is more negative 
than program 2 (240xg for 3 min) and program 3 (300xg for 5 min). The average deviation of program 3 was positive in 
contrast to other programs. The Student’s t-test has shown no significant difference between programs 1 and 2 (p = 0.60). 
Also, there was no significant difference between programs 1 and 3 (p = 0.084) and this was also the case between programs 
2 and 3 (p = 0.11).  

In Figure 5 the average deviation of the number of LX-2 cells after spinning down with respect to 

before, of each centrifuge program is shown. The values of average deviation with standard deviation 

of the three centrifuge programs were near each other, see Figure 5. The data of average deviation 

after spinning down, were analyzed with the Student’s t-test. It was assumed that there was equal 

variance between the data values. The Student’s t-test showed that there was no significant 

difference (p = 0.60) between centrifuge program 1 (90xg for 10 min) and program 2 (240xg for 3 

min). Also, the t-test showed that there was no significant difference (p = 0.084) between program 1 
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and program 3 (300xg for 5 min). For the last comparison, between programs 2 and 3, the Student’s t-

test showed there was no significant difference (p = 0.11) between them. 

3.2 After the Nucleofection® experiment 
To find a suitable Nucleofector® pulse code program to achieve transfection efficiency as high as 

possible in combination with high cell viability of LX-2 cells after Nucleofection® of LX-2 cells with 

CRISPR/Cas9, the two different pulse code programs of Nucleofector® were compared with each 

other after Nucleofection® experiment with pmaxGFP™ vector. The comparison was done on 

transfection efficiency, cell metabolic activity, and confluence of wells with LX-2 cells.  

3.2.1 Measurement of fluorescence signals 

To see if the Nucleofection® of LX-2 cells with pmaxGFP™ was successful, the wells of LX-2 from 

different conditions were analyzed with an Inverted Microscope Ti-E from Nikon. 

Condition 24 hours 48 hours 120 hours 
EW-113 
GFP 

   
CA-137 
GFP 

   
Figure 6: The merged images of LX-2 cells with GFP over time with different Nucleofector® programs are shown. There were 
fluorescent signals visible after 24, 48, and 120 hours of Nucleofection® of LX-2 cells with program EW-113 and CA-137. The 
images were taken at a magnification of 4x with Inverted Microscope Ti-E from Nikon.  

In Figure 6, the merged images of LX-2 cells after Nucleofection® with GFP at different programs over 

time. Here the fluorescent signals were visible after 24 hours of Nucleofection® of LX-2 cells with both 

programs EW-113 and CA-137. The fluorescent signals were also visible after 48 and 120 hours of 

Nucleofection® of LX-2 cells with both programs, see Figure 6. There were no fluorescent signals 

visible at the wells with LX-2 cells without GFP and there were also no fluorescent signals visible at 

the control wells with LX-2 without GFP and without Nucleofection® (data not shown in Figure 6). 

3.2.2 Transfection efficiency of different Nucleofector® pulse code programs 

To achieve transfection efficiency as high as possible with Nucleofection® of LX-2 cells with 

CRISPR/Cas9, the two different pulse code programs of Nucleofector® were compared in transfection 

efficiency after Nucleofection® of LX-2 cells with pmaxGFP® vector.  
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Figure 7: The percentage average transfection efficiency for each pulse code program is shown over time in hours after 
Nucleofection® of LX-2 cells with pmaxGFP® vector. There were no significant differences between EW-113 and CA-137 at 24 
and 48 hours after Nucleofection®. After 120 hours of Nucleofection®, there was a significant difference (p = 0.02) between 
the transfection efficiency of Nucleofection® with the EW-113 program and Nucleofection® with the CA-137 program. Here 
the transfection efficiency of program CA-137 was lower than EW-113. 

In Figure 7 the average transfection efficiency after transfection of LX-2 cells with the pmaxGFP™ 

vector of each different pulse code program is shown. The data of transfection efficiency were 

analyzed and Student’s t-test was used. For the t-test, it was assumed that there was unequal 

variance in the data set. In 24-48 hours after Nucleofection®, the transfection efficiency of both, the 

EW-113 program and the CA-137 program, were comparable (24h: p = 0.14, 48h: p = 0.32). After 120 

hours, the average transfection efficiency decreased for both programs. The transfection efficiency of 

the CA-137 program was significantly lower than EW-113 (p = 0.02). 

3.2.3 Viability of LX-2 cells after Nucleofection® 

To estimate which of the two pulse code programs (EW-113 and CA-137) of Nucleofector® is the best 

choice to achieve high viability of LX-2 cells after Nucleofection®, the LX-2 cells of different conditions 

were analyzed with Alamar Blue assay and the bright field images of LX-2 cells from different 

conditions were assessed with use of ImageJ to determine cell confluence. With these data, the 

differences between the two Nucleofector® programs were analyzed. 

3.2.3.1 Cell metabolic activity 

For the assessment of cell metabolic activity, the data of measured fluorescence intensity from each 

condition were analyzed and compared.  
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Figure 8: The average metabolic activity of transfected LX-2 cells with pmaxGFP™ vector and LX-2 cells without pmaxGFP™ 
vector at different pulse code programs of Nucleofector® with respect to control LX-2 cells which were not in Nucleofector®. 
Here the LX-2 cells without the pmaxGFP™ vector showed comparable metabolic activity with both programs. Also, the 
metabolic activity of the LX-2 cells without the pmaxGFP™ vector of both programs is comparable with the control. The 
metabolic activity of LX-2 cells with pmaxGFP™ of each program was lower than the control. From LX-2 cells with pmaxGFP™ 
vector, the metabolic activity was higher with program CA-137 than with program EW-113. 

In Figure 8, the average metabolic activity of LX-2 cells after Nucleofection® of each pulse code 

program EW-113 and CA-137 is shown with respect to control LX-2 cells without Nucleofection® to 

compare the influence of different pulse code programs at the metabolic activity of LX-2 cells and also 

to compare between transfected LX-2 cells with pmaxGFP vector and LX-2 cells without pmaxGFP 

transfection.  

The LX-2 cells without pmaxGFP™ Nucleofection® with the CA-137 program showed comparable 

average metabolic activity with control. The LX-2 cells without GFP with program EW-113 showed a 

bit higher metabolic activity than the control and also more than program CA-137, see Figure 8.  

The LX-2 cells which were transfected with pmaxGFP™ vector with EW-113 and CA-137 programs, 

showed lower metabolic activity compared with LX-2 with the same Nucleofection® program without 

GFP. The metabolic activity for LX-2 cells with GFP was more than 50% lower than LX-2 cells without 

GFP with program EW-113. Also, for program CA-137 there was more than 40% lower metabolic 

activity with LX-2 cells with GFP than LX-2 cells without GFP, see Figure 8. 

Furthermore, the LX-2 cells with GFP showed 20% higher metabolic activity with CA-137 than with 

EW-113, see Figure 8. 
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3.2.3.2 Confluence assessment with ImageJ 

The calculated data of the average confluence of each condition over time after the Nucleofection® 

experiment were analyzed and compared. Also, the Student’s t-test is used to analyze the confluence 

data. 

 

 

Figure 9: Average confluence of LX-2 cells over time in hours after the Nucleofection® experiment. LX-2 cells without 
pmaxGFP™ vector which were not in Nucleofector®, were taken as control. The cell confluence of LX-2 cells without 
pmaxGFP™ vector with EW-113 was comparable with CA-137 at 24 and 48 hours after Nucleofection®. This was also the 
case for LX-2 with the pmaxGFP™ vector which was also comparable at 24, 48, and 120 hours after Nucleofection. After 120 
hours of the Nucleofection® experiment, there was a significant difference in cell confluence between EW-113 and CA-137 for 
LX-2 cells without the pmaxGFP™ vector (p = 0.02). The confluence was higher with CA-137 than with EW-113. Also, the 
confluence of LX-2 cells without pmaxGFP™ vector with CA-137 was comparable with the control after 120 hours. The 
confluence of LX-2 cells without GFP with program EW-113 was significantly lower than the control (p = 0.04). LX-2 cells 
without the pmaxGFP™ vector with both programs showed higher confluence after 120 hours than LX-2 cells with the 
pmaxGFP™ vector. The student’s t-test showed there was a significantly higher confluence of LX-2 cells without GFP than LX-2 
cells with GFP with the same program CA-137 after 120 hours (p = 0.009). Also, there was a significantly higher confluence of 
LX-2 cells without GFP than LX-2 cells with GFP with the same program EW-113 after 120 hours (p = 0.004). 

In Figure 9, the average confluence of LX-2 cells with and without pmaxGFP™ vector over time in 

hours after Nucleofection® with different programs are shown. The LX-2 cells without GFP and 

Nucleofection® are taken as control. After 24 and 48 hours, there was no significant difference in the 

average confluence between program EW-113 and CA-137 for LX-2 cells without GFP, see Figure 9. 

However after 120 hours, there was a significantly higher average confluence (p = 0.02) with program 

CA-137 than with EW-113, see Figure 9. This was also the case between control and LX-2 cells without 

GFP with program EW-113 (p = 0.04). The average confluence between control and LX-2 cells without 

GFP with program CA-137 was comparable to each other over time after Nucleofection®. 

0

10

20

30

40

50

60

70

80

90

100

24 48 120

A
ve

ra
ge

 c
o

n
fl

u
en

ce
 [%

]

Hours after Nucleofection®

EW-113

CA-137

EW-113 (no GFP)

CA-137 (no GFP)

Control



16 
 

For the LX-2 cells with GFP, the average confluence was comparable with both programs, EW-113 and 

CA-137 at 24, 48, and 120 hours after Nucleofection®. The average confluence of the LX-2 cells with 

GFP was not significantly changed after 120 hours in comparison with 24 hours and 48 hours after 

Nucleofection® for both programs. The confluence of LX-2 cells without GFP was higher with both 

programs than LX-2 cells with GFP after 120 hours. 

4. Discussion 

4.1 Centrifuge configurations 
For Nucleofection® there are 150.000 cells needed per sample. Before Nucleofection®, a master cell 

suspension will be made with 150.000 cells per sample and this suspension needs to be centrifuged 

to remove the supernatant. After this, the Nucleofector® Solution can be added to the cell pellet for 

the Nucleofection® experiment. For centrifugation, there were three configurations available as 

follows: Program 1 with 90xg for 10 min, program 2 with 240xg for 3 minutes, and program 3 with 

300xg for 5 min. The experiments were executed to investigate which of the three programs has the 

least cell loss. The results of the experiments with different centrifuge programs are shown in Figure 

5. 

Figure 5 shows that the average deviation after spinning down with program 1 (90xg for 10 min) was 

comparable with program 2 (240xg for 3 min). The duration of the centrifuge with Program 1 is 

around 3 times longer than program 2. But the force of program 2 is also around 3 times higher than 

program 1. So this may have led to a comparable result. Program 3 (300xg for 5 min) takes almost 2 

times longer than program 2 and program 3 has also ¼ times more force than program 2 so here it 

was expected to have less cell loss with program 3 than 2. In Figure 5 it was shown that program 3 

was on average deviation less cell loss than other programs, it has more cells than before which was 

not expected. However, the Students’ t-test showed there was no significant difference between 

program 3 and the other programs. So no reliable statement can be made on these results about 

which configuration has the least cell loss. 

There were on average more LX-2 cells after centrifuging with program 3 than before centrifuging, 

which was not expected. Probably there were more cells in the tubes before centrifuging than was 

counted, or fewer cells in the tubes after centrifuge than was counted by LUNA-II™ Automated Cell 

Counter. LUNA-II™ Automated Cell Counter is accurate with detecting cells when the concentration of 

cell suspension is in the range of 5 x 104 to 1 x 107 cells/ml and the size of the cells is in the range of 3 

to 60 µm [29],[30]. Also, this device has software to automatically detect clumped cells and it can 

decompose the agglomerated cells into single cells to count them [30]. To avoid clumping of cells the 

cell suspensions are well resuspended before taking a part of the suspension for cell counting. In the 

experiment, it was chosen to transfer 60.000 cells to each tube for spinning down with a centrifuge. 

Because of this small amount of total cells per tube, there was only a maximum of 100 µl taken from 

4 ml master cell suspension per tube before centrifuging. After transferring the volumes to each tube 

to get 60.000 cells, again 10 µl of this volume was taken for cell counting. That is already 1 of 10 of 

the volume. So this means there is already 1 of 10 of the calculated number of cells in the tube less 

before centrifuging the tubes. If the counted number of cells was indeed 60.000 cells, then there 

were only 54.000 cells left for centrifuging. This concentration is very close to the minimum 

concentration to accurately count the cells with LUNA-II™. So here the chance to have an inaccurate 

counted cells/ml was present after centrifuging. This could explain the larger differences between 

samples in duplicate after centrifugation of the same program than before. Furthermore, it could 

explain that there were more cells/ml counted after centrifugation with program 3 than before. 

Besides cell counting, the supernatant was extracted with an aspiration system after centrifugation, 
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which was quite difficult with small volumes to be sure to have extracted the whole supernatant. 

Because of these small volumes, it can lead to bigger differences in deviations between the same 

tubes of the same program.  

The program with 90xg for 10 min, was recommended by Lonza to increase cell viability [21],[22]. In 

this research, the focus was to get the least cell loss, so the cell viability was not investigated. 

Program 2 with 240xg for 3 min is used in the general protocol to spin down the human pluripotent 

stem cells. For spinning down the LX-2 cells, the configuration of 300xg for 5 min is used in the 

general protocol from Sigma-Aldrich [24]. So for Nucleofection® of LX-2 cells, it is chosen to use 300xg 

for 5 min because it is generally used for the LX-2 cells. 

4.2 Transfection efficiency 
The transfection efficiency was decreased for both programs, EW-113 and CA-137 120 hours after 

Nucleofection® (see Figure 7) which was expected because the intensity and fluorescence signals will 

decrease over time due to degradation of the GFP vector. Also, the number of cells without the 

pmaxGFP™ vector will increase. Because there are cells that were not transfected, which will divide. 

Furthermore, the pmaxGFP™ vector will not integrate into the DNA of LX-2 cells so the pmaxGFP™ 

vector will not replicate when the cells are dividing. So the number of cells without the pmaxGFP™ 

vector will increase over time in contrast to cells with the pmaxGFP™ vector. This will lead to lower 

transfection efficiency over time. Figure 7 shows that the transfection efficiency of LX-2 cells with CA-

137 was lower than with EW-113 after 120 hours of Nucleofection® experiment which can be caused 

by the difference between the number of cells without GFP and the number of cells with GFP at both 

programs. If there were more LX-2 cells without GFP vector before 120 hours with program CA-137 

than with program EW-113, the number of cells without GFP will increase faster with CA-137 because 

the cells divide exponentially. So this could explain a lower transfection efficiency after 120 hours 

with CA-137 than EW-113.  

For transfection of LX-2 cells with CRISPR/Cas9, both programs are suitable because in Figure 7 was 

visible that the transfection efficiency of both programs was comparable at 24 hours and 48 hours 

after Nucleofection®. The transfection efficiency was around 37% for EW-113 and 40% for CA-137 

after 24 hours. When the CRISPR/Cas9 is transfected into the LX-2 cells, the LPA receptor gene will be 

knocked out permanently in DNA. So when an LX-2 cell with this knocked-out gene divides, the 

daughter cells will have also the knocked-out gene. 

4.3 Cell metabolic activity 
In Figure 8, it is shown that the LX-2 cells without GFP have comparable average metabolic activity 

with both programs EW-113 and CA-137 and also have comparable metabolic activity as the control. 

Also in Figure 8 is shown that LX-2 cells with a GFP vector have lower metabolic activity with both 

programs than LX-2 cells without GFP and control. This is expected because the transfection with the 

pmaxGFP™ vector can be toxic for the LX-2 due to the length of this plasmid which is around 3.5 kb 

long [31]. In a research (Weiwei et al., 2023) the influence of two different sizes of plasmids on 

transfection efficiency and viability was investigated after Nucleofection® of Porcine fetal fibroblasts 

(PFFs) with several pulse code programs, including CA-137 [31]. In this study was shown that the 

survival rate of PFFs with pmaxGFP™ after Nucleofection® with several pulse code programs including 

CA-137, was lower than the control. Here the survival rate was around 70% with 0.265 µg pmaxGFP™ 

vector which is 1/3 of the used concentration of the same vector for Nucleofection® of LX-2 cells [31]. 

Also in the study (Weiwei et al., 2023) was shown that increasing of concentration of a 13 kb plasmid 

led to lower survival rates of the cells. 
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Figure 8 shows that the LX-2 cells with GFP had a higher average cell metabolic activity after 

Nucleofection® with program CA-137 than with program EW-113. On the brightfield images of LX-2 

cells with GFP before the Alamar Blue assay experiment, there was not a big difference between both 

programs in the number of LX-2 cells after 168h of Nucleofection® with respect to the difference in 

metabolic activity of 26%, see Appendix 7.6 for brightfield images. So it seems that the difference in 

metabolic activity is caused by the difference in properties between EW-113 and CA-137. So from 

this, it can be said that CA-137 is a better program for Nucleofection® of LX-2 cells with a plasmid to 

get the highest cell metabolic activity after Nucleofection®. 

4.4 Cell confluence 
In Figure 9, the LX-2 cells without GFP showed with both programs EW-113 and CA-137 a higher 

average confluence after 120 hours than LX-2 cells with GFP. This difference can be caused by the 

toxicity of the pmaxGFP™ vector for the LX-2 cells which was also the case with the results of cell 

metabolic activity, see Chapter 4.3. The difference between EW-113 and CA-137 was significantly 

bigger for LX-2 cells without GFP than for LX-2 cells with GFP after 120 hours. It seems that the 

confluence of LX-2 cells without GFP increased at the same speed as the control, while the confluence 

of LX-2 cells without GFP with EW-113 was less changed from 48 hours to 120 hours after 

Nucleofection®. There was no significant difference between both programs with LX-2 cells without 

GFP at 24 and 48 hours after Nucleofection®. This was also the case for LX-2 cells with GFP, there was 

no significant difference between the two programs at 24 and 48 hours after Nucleofection®, but 

after 120 hours there was still no significant difference between the two programs for LX-2 cells with 

GFP. The confluence of LX-2 cells with GFP remained the same over time after Nucleofection® with 

both programs while confluence of LX-2 cells without GFP and control was increased after 120 hours 

of Nucleofection®. This difference is probably caused by the toxicity of pmaxGFP™ plasmid. So from 

the results, it can only be said that CA-137 was better than EW-113 for LX-2 cells without GFP.  

4.5 Summary discussion of results of the Nucleofection® experiment 
To determine which pulse code program is the best choice for Nucleofection® of LX-2 cells with 

CRISPR/Cas9, the most important results are shown in Table 2 as an overview. The results of 

transfection efficiency are only shown 24 hours after Nucleofection because when CRISPR/Cas9 is 

successfully transfected in cells, the specific gene in the DNA of the transfected cells will be knocked 

out and this will be passed to daughter cells after dividing. So the number of cells with knocked out 

gene will increase over time. While the number of cells with GFP will remain the same or decrease 

over time. The results of cell confluence are shown in Table 2 from 120 hours after Nucleofection® 

because it was shown that there was no significant difference between both programs after 24 and 

48 hours of Nucleofection® for LX-2 cells with GFP and without GFP.  

Table 2: Overview of the most important results of transfection efficiency, metabolic activity, and cell confluence after 
Nucleofection® of LX-2 cells with both programs EW-113 and CA-137. The colors are given to each Nucleofector® program 
based on a comparison of results between both programs after Nucleofection® of LX-2 with pmaxGFP™ vector. The same is 
done for LX-2 cells without GFP. Green = good, orange = average, and red = bad.  

Program Efficiency (24h) Metabolic activity Confluence (120h) 

EW-113 (+GFP) ~37% ~31% ~12% 

CA-137 (+GFP) ~40% ~57% ~14% 

EW-113 - ~105% ~46% 

CA-137 - ~101% ~75% 

 

From the overview of results in Table 2, it can be concluded that program CA-137 is the most suitable 

program for Nucleofection® of LX-2 cells to have the highest cell viability combined with good enough 
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transfection efficiency. For Nucleofection® of LX-2 cells with CRISPR/Cas9, the cell viability can be 

increased by transfecting the CRISPR/Cas9 as a ribonucleoprotein (RNP) instead of as plasmid 

[32],[33]. Also transfecting the Cas9 with sgRNA as RNP complex decreases the frequency of off-

target editing while plasmid with CRISPR/Cas9 has higher frequency off-target editing and increases 

the chance of integration of plasmid into DNA of cells which can lead to insertional mutagenesis 

[32],[33]. 

4.6 Limitations and recommendations 
The experiments for testing different centrifuge programs were done with a low amount of cells per 

tube (60.000) which was close to the minimum number of cells/ml of LUNA-II™ Automated Cell 

Counter (minimum of 50.000) to be accurate with counting. For the next time, it is recommended to 

transfer a higher amount of cells to each tube to test the configurations of the centrifuge to avoid 

inaccurate cell counting by LUNA™ and also to avoid having small volumes of cell suspension form 

which makes it difficult to extract the whole supernatant. Besides, there was a high deviation 

between two tubes of the same program after centrifugation, which was not taken into account in 

the data analysis. For next time it is recommended to do statistical analysis with coefficient of 

variations on the duplicate samples to exclude experiments with high differences between duplicate 

samples. Also, it might be interesting to investigate cell viability after centrifuging at different 

centrifuge programs besides determining which program has the least cell loss. Because for 

Nucleofection® it is also important to have cells with high enough cell viability. Lastly, it would be 

interesting to investigate the difference in the accuracy of cell counting between LUNA-II™ and doing 

it manually with a hemocytometer.  

Transfection efficiency determination was done by hand with the use of ImageJ by zooming in at 

150% in an area that was the most representative of the whole well. This can lead to less reliable 

results. For next time it is recommended to develop a protocol to count automatically the cells 

without green fluorescent signals and cells with green fluorescent with the use of ImageJ.  

In this research, fluorescence-activated cell sorting (FACS) was used to determine the transfection 

efficiency of different programs, but there was no significant difference between the programs which 

was probably caused by the low number of cells. If it is possible, would be recommended to add extra 

well in the Nucleofection® experiment for each condition with GFP vector, to use this for FACS. In this 

research, there was one well of each condition divided into three wells after Nucleofection® which 

might have led to a lower number of cells to use it for FACS.  

For determining cell metabolic activity of cells after Nucleofection®, the Alamar Blue assay was done 

168 hours after the Nucleofection® experiment. That would be interesting to do it also 24 hours after 

Nucleofection® to investigate the influence of both pulse code programs EW-113 and CA-137 on LX-2 

cells. 

The protocol for measuring cell confluence on images with the use of ImageJ worked quite well for 

images with high enough contrast. The images of 168 hours after Nucleofection® were not taken with 

high enough contrast which led to less reliable measurements of cell confluence with ImageJ. The cell 

confluence was almost 100%, but the protocol with ImageJ measured around 30% lower cell 

confluence. For next time it is important to make images of cells with high enough contrast for more 

reliable measurements of the area of cells. 

In future research, it would be interesting to analyze the morphology of LX-2 cells after the 

Nucleofection® experiment to investigate the influence of different Nucleofector® programs on the 

LX-2 cells and also to investigate the influence of pmaxGFP™ vector on the morphology of LX-2 cells. 

Because of time, it was chosen to not analyze the morphology in this research. 
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5. Conclusion 
In this research, the Nucleofector® pulse code programs EW-113 and CA-137 were compared to each 

other based on transfection efficiency, metabolic activity, and cell confluence of LX-2 cells after 

Nucleofection® of each program to find the optimized protocol for Nucleofection® of LX-2 cells with 

CRISPR/Cas9 to create a LX-2 cell line with knock-out of LPARs. Based on the results, the pulse code 

program CA-137 has comparable transfection efficiency with EW-113 after 24 hours of Nucleofection® 

but CA-137 has the highest cell viability which is important to create a LX-2 cell line with knock-out of 

LPARs. 
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7. Appendix 

7.1 Protocol: Subculturing LX-2 cells 
 

LX2 cell culture (T-25 tissue culture treated) 

Materials: 

• Culture medium: DMEM + 10% FBS + 1% pen/strep + L-Glutamax 

• PBS 

• Trypsin-EDTA (0.05%) 

• T-25 tissue culture treated flask 

Protocol: 

Passage them when they are almost 100% confluent (twice a week). 

Passage them 1:5 

Preheat the media, PBS, and trypsin in the bath at 37oC. 

1. Extract the media using the aspiration system 

2. Wash 2x with 1 ml PBS by pipetting PBS on the side of the T-25 culture flask and swirl the PBS 

across the bottom by swirling the flask and extract PBS by using the aspiration system. 

3. Add 0.25 ml trypsin (divide well) 

4. Incubate for 5 min at room temperature, tap against the sidings (check with the microscope 

to see if the cells have detached from the bottom) 

5. During incubation add 6 ml culture medium in a new T-25 culture flask, write on the flask the 

cell type, passage number, passage ratio, date, and your name (write this also down in your 

lab journal) 

6. Add 1.75 ml culture medium to the trypsinized cells and resuspend 

7. Add 400 µl cell suspension to the new flask (1:5 passage) 

8. Control using the microscope if the cells are present in the flask 

 

7.2 Protocol: Subculturing LX-2 cells and testing different centrifuge protocols 
 

LX2 cell culture (T-25 tissue culture treated) and testing different centrifuge protocols 

Materials: 

• Culture medium: DMEM + 10% FBS + 1% pen/strep + L-Glutamax 

• PBS 

• Trypsin 

• T-25 tissue culture treated flask 

• 15 ml tubes 

Protocol: 

Passage them when they are almost 100% confluent (twice a week). 

Passage them 1:5 
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Preheat the media, PBS, and trypsin (half an hour before passage) in the bath at 37oC. 

1. Extract the media using the aspiration system 

2. Wash 2x with 1 ml PBS by pipetting PBS on the side of the T-25 culture flask and swirl the PBS 

across the bottom by swirling the flask and extract PBS by using the aspiration system. 

3. Add 0.25 ml trypsin (divide well) 

4. Incubate for 5 min at room temperature, tap against the sidings (check with the microscope 

to see if the cells have detached from the bottom) 

5. During incubation add 6 ml culture medium in a new T-25 culture flask, write on the flask the 

cell type, passage number, passage ratio, date, and your name (write this also down in your 

lab journal) 

6. Add 3.75 ml culture medium to the trypsinized cells and resuspend. So end volume is now 4 

ml. 

7. Take 4 ml of cell suspension from the old T-25 culture flask with a pipetboy and add it to a 15 

ml tube and resuspend well. Label this tube as ‘master’.  

8. Take 10 µl from the center of the cell suspension and add it to one side of the LUNA™ Cell 

Counting Slide. 

9. Use LUNA-II™ Automated Cell Counter to count the number of living cells per ml.  

In the settings of LUNA-II™ set Protocol on ‘new protocol’ and set the option “Without Trypan 

Blue staining” and write down the number of living cells per ml in the lab journal. See Table 1 

for the overview of the settings of LUNA-II. 

Table 3: Settings of protocol ‘new protocol’ of LUNA-II: 

Dilution 
Factor  
(1-100) 

Noise 
Reduction 
(1-10) 

Live Cell 
Sensitivity 
(1-9) 

Roundness 
(0-100%) 

Min. Cell 
Size (3-
59 µm) 

Max. Cell 
Size (4-
60 µm) 

Declustering 
Level 

1 5 1 60 3 60 Medium 

 

10. Calculation to get for example 60.000 cells per tube: 

60.000

𝑇𝑜𝑡𝑎𝑙 𝑐𝑜𝑢𝑛𝑡𝑒𝑑 𝑛𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑙𝑖𝑣𝑖𝑛𝑔 𝑐𝑒𝑙𝑙𝑠 𝑝𝑒𝑟 𝑚𝑙
= 𝑡𝑜𝑡𝑎𝑙 𝑚𝑙 𝑜𝑓 𝑐𝑒𝑙𝑙 𝑠𝑢𝑠𝑝𝑒𝑛𝑠𝑖𝑜𝑛 𝑡𝑜 𝑝𝑎𝑠𝑠 𝑝𝑒𝑟 𝑚𝑙 

 We want to fill 6 tubes with 60.000 cells. So there must be at least 360.000 cells in the flask. 

The calculation to get the total cells in the flask:  

4 ml (end volume of old T-25 flask) x Total counted number of living cells per ml = Total cells in 

flask.  

11. Calculation of how much of cells need to be passed to the new T-25 flask: 

𝑇𝑜𝑡𝑎𝑙 𝑐𝑒𝑙𝑙𝑠 𝑖𝑛 𝑓𝑙𝑎𝑠𝑘 ∗ 𝑟𝑎𝑡𝑖𝑜 𝑡𝑜 𝑝𝑎𝑠𝑠 = 𝑛𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑐𝑒𝑙𝑙𝑠 𝑛𝑒𝑒𝑑𝑒𝑑 𝑡𝑜 𝑝𝑎𝑠𝑠 𝑡𝑜 𝑛𝑒𝑤 𝑓𝑙𝑎𝑠𝑘. 

Or: 

𝑇𝑜𝑡𝑎𝑙 𝑣𝑜𝑙𝑢𝑚𝑒 𝑓𝑙𝑎𝑠𝑘 ∗ 𝑟𝑎𝑡𝑖𝑜 𝑡𝑜 𝑝𝑎𝑠𝑠 = 𝑛𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑣𝑜𝑙𝑢𝑚𝑒 𝑛𝑒𝑒𝑑𝑒𝑑 𝑡𝑜 𝑝𝑎𝑠𝑠 𝑡𝑜 𝑛𝑒𝑤 𝑓𝑙𝑎𝑠𝑘. 

Ratio to pass cells, for example, 1:5. 

12. Take six 15 ml tubes and numerate the tubes from 1 to 6. Depending on the total cells in the 

flask. If there are not enough cells left, take four tubes or two tubes instead of six tubes. Or 

change the total number of cells per tube instead of 60.000 cells. 

13. Resuspend the cell suspension of the master tube and take ‘total ml of cell suspension to pass 

per ml’ + 10 µl to add to each tube with one pipette tip. Resuspend well every time before 

taking cell suspension from the master tube! 
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14. Take 10 µl from the center of the cell suspension and add it to one side of the LUNA™ Cell 

Counting Slide. Repeat it for the other tubes. 

15. Set Centrifuge on the correct radius in settings (137) and be sure RCF is switched on. 

16. Insert two tubes into the centrifuge with the following program: 

Program 1: 90xg for 10 minutes 

Then insert the other two tubes into the centrifuge with the following program: 

Program 2: 240xg for 3 minutes 

After this, insert the last two other tubes into the centrifuge with the following program: 

Program 3: 300xg for 5 minutes 

17. Remove the supernatant completely by using an aspiration system. Keep yet above cell pellet. 

18. Add 500 µl culture medium to tubes and resuspend it well to get homogeneous cell 

suspension. 

19. Take 10 µl from the center of the cell suspension and add it to one side of the LUNA™ Cell 

Counting Slide. Repeat it for the other tube of the same program. 

20. Use LUNA-II™ Automated Cell Counter to count the number of living cells per ml.  

In the settings of LUNA-II™ set Protocol on ‘New protocol’ and set the option “Without 

Trypan Blue staining” and write down the number of living cells per ml in the lab journal. 

21. Repeat steps 18 and 19 for other tubes. 

22. Add 800 µl cell suspension from tubes with cell suspension to the new flask (1:5 passage) or 

add the number of ml to pass to get the total of needed cells in the new T-25 flask.  

 

All tubes, except the ‘master’ tube, have 60.000 cells in 1 ml cell suspension. The calculation 

below is to calculate the total ml of cell suspension (tubes with 60.000 cells in 1 ml 

suspension) to pass to the new T-25 flask.  
𝑇𝑜𝑡𝑎𝑙 𝑛𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑐𝑒𝑙𝑙𝑠 𝑛𝑒𝑒𝑑𝑒𝑑 𝑡𝑜 𝑝𝑎𝑠𝑠

60.000
= 𝑡𝑜𝑡𝑎𝑙 𝑚𝑙 𝑜𝑓 𝑐𝑒𝑙𝑙 𝑠𝑢𝑠𝑝𝑒𝑛𝑠𝑖𝑜𝑛 𝑡𝑜 𝑝𝑎𝑠𝑠. 

 

23. Control using the microscope if the cells are present in the new T-25 flask 

 

7.3 Protocol: Nucleofection® of LX-2 cells with pmaxGFP™ vector 

 
Protocol Transfection LX-2 cells with pmaxGFP™ vector with 4D-Nucleofector® 
This protocol is based on Amaxa™ 4D-Nucleofector™ Optimization Protocol for Cell Lines from Lonza 

[21]. 

Nucleofector® materials: 
- 4D-Nucleofector® Core Unit (Lonza) 

- 4D-Nucleofector® X unit (Lonza) 

- SE Cell Line 4D-Nucleofector™ X kit S (Lonza) 

Once the optimal conditions have been determined with pmaxGFP™ Positive Control Vector, they 

remain the same whether DNA- or RNA-based substrates (or both together) are transfected. 

Aim of this experiment: 

- To check whether the LX-2 cells are successfully transfected → expression of the GFP gene. 

- To check the cell viability of LX-2 cells after nucleofection. 

To answer the research question: which pulse code protocol has the best efficiency of transfecting LX-

2 cells and has the best cell viability? 
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Conditions: 
Condition 1: LX-2 cells with pmaxGFP™ vector. 

Do electroporation with program EW-113. 

Condition 2: LX-2 cells without pmaxGFP™ vector. 

Do electroporation with program EW-113. 

Condition 3: LX-2 cells with pmaxGFP™ vector. 

Do electroporation with pulse code CA-137. 

Condition 4: LX-2 cells without pmaxGFP™ vector. 

Do electroporation with pulse code CA-137. 

Condition 5: LX-2 cells without pmaxGFP™ vector. 

Not inserted into 16-well Nucleocuvette® Strip for Nucleofection®. Only plated on the 24-well plate. 

 

In Table 4 the format of 16-well Nucleocuvette® Strip with conditions is shown. 

Table 4: Conditions per well of 16-well Nucleocuvette® Strip (20 µl per well).  

Plate 1 A B C D E F G H 

2 + 
PC: CA-
137 
 

X 
PC: CA-
137 

Empty Empty Empty Empty Empty Empty 

1 + 
PC: EW-
113 

X 
PC: EW-
113 

Empty Empty Empty Empty Empty Empty 

PC = Pulse code program 

+ = With pmaxGFP™ vector 

X = No pmaxGFP vector added 

Protocol Nucleofection® 
ML-II lab from PDT: 

1. Culturing of LX-2 cells 
Follow the protocol of subculturing LX-2 cells.  

It is recommended to subculture 1-2 days before Nucleofection®. 

The optimal confluency of LX-2 cell culture for Nucleofection® is between 70% and 85%. 

Amount of cells needed per sample for Nucleofection®: 150.000 cells per sample. 

2. Preparing samples for Nucleofection® 

Preparation of Nucleofection® Solution and working solution of pmaxGFP™ 
Materials: 

• SE Cell Line Nucleofector® Solution 

• Nucleofector® Supplement 1 
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• pmaxGFP™ stock solution 

• Tubes Eppendorf 

• Sterile water (MilliQ) 

• Corning® LSE™ Mini microcentrifuge 

• Box with ice for working solution pmaxGFP™ vector and Nucleofection solution 

 

1. Make one master tube enough for six samples (with one extra): 

Add 98.4 µl of SE Cell Line Nucleofector® Solution to the tube and add 21.6 µl of 

Nucleofector® Solution Supplement 1 to the tube. Total volume: 120 µl. 

 

If needed: for one sample with Nucleofector® Solution, 3.6 µl of Nucleofector® 

Solution Supplement 1 and 16.4 µl of SE Cell Line Nucleofector® Solution are needed. 

The ratio of Nucleofector™ Solution to supplement is 4.5 : 1 

2. Prepare pmaxGFP™ Vector: 

Stock solution of pmaxGFP™ vector = 1 µg/µl 

The stock solution of the pmaxGFP™ vector will be diluted to a concentration of 0.4 

µg/µl. So stock solution needs to be diluted by 2.5x.  

→ add 1.5 µl distilled water to 1 µl of stock solution pmaxGFP™.  

The total volume of this solution is 2.5 µl.  

For three samples (one extra sample included): 

Take 3 µl of stock solution (3 µg total pmaxGFP™) and add it to a tube.  

Dilution: add 4.5 µl distilled water to tube → 7.5 µl total volume working solution 

with a concentration of 0.4 µg/µl pmaxGFP™.  

3. After preparation, put the working solution of pmaxGFP™ and Nucleofector® Solution 

on ice. 

 

Preparation of cells for Nucleofection® 
Follow the protocol below for LX-2 cells: 

Materials: 

• Culture medium: DMEM + 10% FBS + 1% pen/strep + L-Glutamax 

• PBS 

• Trypsin 

• T-75 tissue culture treated flask 

• Tubes from Eppendorf 

• RPMI 1640 with supplements (10% FBS, 1% L-glutamine, and 1% pen/strep) 

• Cell transport box to transport from ML-II lab to BIC-Lab 

Protocol: 

Preheat the media, PBS, and trypsin in the bath at 37oC. 

1. Extract the media using the aspiration system. 

2. Wash 2x with 3 ml PBS by pipetting PBS on the side of the T-75 culture flask and swirl the PBS 

across the bottom by swirling the flask and extract PBS by using the aspiration system. 
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3. Add 0.5 ml trypsin (divide well). 

4. Incubate for 5 min at room temperature, tap against the sidings (check with the microscope 

to see if the cells have detached from the bottom). 

5. Add 10 µl of the cell suspension to one side of the LUNA™ Cell Counting Slide. 

6. Use LUNA-II™ Automated Cell Counter to count the number of living cells per ml.  

In the settings of LUNA-II™ set Protocol on ‘new protocol’ and set the option “Without Trypan 

Blue staining” and write down the number of living cells per ml in the lab journal. 

 

Settings of protocol ‘new protocol’ of LUNA-II: 

Dilution 
Factor  
(1-100) 

Noise 
Reduction 
(1-10) 

Live Cell 
Sensitivity 
(1-9) 

Roundness 
(0-100%) 

Min. Cell 
Size (3-
59 µm) 

Max. Cell 
Size (4-
60 µm) 

Declustering 
Level 

1 5 1 60 3 60 Medium 

 

7. Calculation to get 150.000 cells: 

150.000

𝑇𝑜𝑡𝑎𝑙 𝑐𝑜𝑢𝑛𝑡𝑒𝑑 𝑛𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑙𝑖𝑣𝑖𝑛𝑔 𝑐𝑒𝑙𝑙𝑠 𝑝𝑒𝑟 𝑚𝑙
= 𝑡𝑜𝑡𝑎𝑙 𝑚𝑙 𝑜𝑓 𝑐𝑒𝑙𝑙 𝑠𝑢𝑠𝑝𝑒𝑛𝑠𝑖𝑜𝑛 𝑡𝑜 𝑝𝑎𝑠𝑠 𝑝𝑒𝑟 𝑚𝑙 

8. Make one master 15 ml tube of cell suspension: 

Add 6x ‘total ml of the cell suspension to pass per ml’ to the master tube (for 5 samples and 1 

extra). Also, take one 15 ml tube and fill it with the same volume with MilliQ instead of cell 

suspension. It will be used as a counterweight for the centrifuge. 

9. Add 0.5 ml of culture medium (DMEM + 10% FBS + 1% pen/strep + L-Glutamax) to each well 

of the 24-well plate according to Table 5. Also, add 0.5 ml PBS to each well according to Table 

5. A total of 8 ml of culture medium and a total of 5 ml of PBS are needed (inclusive extra 0.5 

ml). And draw the table format on the cover of the 24-well plate. (only the row A-F and 

column 1-4). Also write down your name, date, and cell type on the cover of the 24-well 

plate. 

Table 5: Format of 24-well plate as preparation 

 A B C D E F 

1 PBS Culture 
medium 

Culture 
medium 

Culture 
medium 

Culture 
medium 

PBS 

2 PBS Culture 
medium 

Culture 
medium 

Culture 
medium 

Culture 
medium 

PBS 

3 PBS Culture 
medium 

Culture 
medium 

Culture 
medium 

Culture 
medium 

PBS 

4 PBS Culture 
medium 

Culture 
medium 

Culture 
medium 

PBS PBS 

 

10. Prepare one Eppendorf tube with 1 ml RPMI 1640 with supplements (10% FBS, 1% L-

glutamine, and 1% pen/strep). 

11. Use Parafilm tape to tape around the prepared 24-well plate. Also use Parafilm tape to close 

the tubes with cell suspension, RPMI medium, working solution of pmaxGFP™ vector, and 

Nucleofection® Solution. 

12. Put the tubes with cell suspension, RPMI medium, and the prepared 24-well plate in the Cell 

transport box. Also, put the tubes with the working solution of pmaxGFP™ vector and 
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Nucleofection® Solution on ice in the container. Take the Cell transport box and container 

from ML-II PDT to ML-II BIC lab where Nucleofection® will be executed.  

 

When arrived, pre-incubate/equilibrate the prepared 24-well plate and tube with RPMI 

medium in a humidified 37oC/ 5% CO2 incubator. 

3. Pre Nucleofection® 
Important note: 

As leaving cells in Nucleofector™ Solution for extended periods may lead to reduced 

transfection efficiency and cell viability, it is important to work as quickly as possible. Avoid air 

bubbles while pipetting. 

1. Start the 4D-Nucleofector® System and create an experimental parameter file 

1. First choose the X unit strip (16-wells) vessel to start an experiment 

2. Give the name of the experiment 

The experiment parameters overview will be shown. 

2. Select a single well or a set of vessels: see Table 4 for the used wells 

3. Select Sample type: 

- Sample → for substrate-containing samples that will be pulsed 

- No DNA → for samples without any substrate (pulse control) 

- No Prog → for samples with a substrate not being subjected to an 

electrical pulse (no-pulse control) 

For running the program:  

1. Select sample (A1 well) 

2. Select sample (A2 well) 

3. Select No DNA (B1 well) 

4. Select No DNA (B2 well) 

 

4. Enter Pulse code: 

- Enter code EW-113 for A1 and B1. 

- Enter code CA-137 for A2 and B2. 

5. Centrifuge the master tube with LX-2 cells with a counterweight tube with MilliQ at 300xg for 

5 minutes at room temperature. 

6. Prepare five Eppendorf tubes by labeling them as following: 

Tube 1: A1 

Tube 2: A2 

Tube 3: B1 

Tube 4: B2 

Tube 5: 5  

7. Remove the supernatant completely by using an aspiration system. Keep yet above cell pellet. 

8. Add 30 µl Nucleofector® Solution to the cell pellet of the master tube and resuspend 

carefully. 

 

9. Take the prepared five tubes (A1, A2, B1, B2 and 5) and fill these tubes as following: 

Tube A1 and A2: add 2 µl of solution with pmaxGFP™ vector to each tube. Also, add 13 µl of 

Nucleofector® Solution to each tube. The total volume is now 15 µl for each of these tubes. 
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Tube B1 and B2: add 15 µl of Nucleofector® Solution to each tube. These tubes are negative 

controls (and pulse controls). 

Tube 5: Add 15 µl of Nucleofector® Solution 

10. Add 5 µl of master mix with LX-2 cells to each tube of the five tubes. Now each tube has 20 µl 

as reaction volume. 

11. Insert the 16-well Nucleocuvette™ Strip into a blue holder and transfer 20 µl of all four tubes 

(A1, A2, B1, and B2) into the wells of the 16-well Nucleocuvette™ Strip. See Table 6. 

Use the blue micropipette with the yellow button on the plunger which has small pipet tips. 

Get rid of bubbles! 

Table 6: Format of the 16-well Nucleocuvette™ Strip to fill. 

Strip 1 A B C D E F G H 

2 Tube A2 
 

Tube B2 X X X X X X 

1 Tube A1 Tube B1 X X X X X X 

X = empty. 

 

NOTE: Don’t touch the metal bottom of the Nucleocuvette™ Strip! It contains 

electrodes. 

12. Leave tube 5 at room temperature. 

 

4. Nucleofection® Process 
1. Gently tap the Nucleocuvette™ Strip to make sure the sample covers the bottom of 

the cuvette. Tap carefully the Nucleocuvette™ Strip with the bottom on the counter 

of the LAF cabinet 

NOTE: Don’t touch the metal bottom of the Nucleocuvette™ Strip! It contains 

electrodes.  

2. Place Nucleocuvette™ Strip with the lid closed into the retainer of the 4D-

Nucleofector™ X Unit. Check for proper orientation of the Nucleocuvette™ Strip. The 

yellow button at the top of the blue holder indicates the orientation of the strip.  

3. Start the Nucleofection™ process by pressing the “Start” on the display of the 4D-

Nucleofector™ Core Unit. 

4. After run completion, carefully remove the Nucleocuvette™ Strip from the retainer. 

5. Incubate the Nucleocuvette™ Strip for 10 minutes at room temperature. 

6. During incubation, take four new tubes of Eppendorf and label them with numbers 1 

to 5. 

7. Add 80 µl pre-warmed RPMI 1640 with supplements (10% FBS, 1% L-glutamine, and 

1% pen/strep) to each well of Nucleocuvette™ Strip and also add it to tube number 5.   

Resuspend the samples by gently pipetting up and down two to three times to mix 

the cells with RPMI 1640 with supplements. Now each well has a volume of 100 µl. 

8. Place the 16-well Nucleocuvette™ Strip and tube number 5 in a humidified 37oC/ 5% 

CO2 incubator for 10 minutes. 
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9. After incubation, take from Nucleocuvette™ Strip the whole volume of each well as 

the following: 

i. Well A1 to tube 1 

ii. Well A2 to tube 2 

iii. Well B1 to tube 3 

iv. Well B2 to tube 4  

And transfer the whole volume of tube number 5 to new tube number 5. 

10. Add 20 µl pre-warmed RPMI with supplements (10% FBS, 1% L-glutamine, and 1% 

pen/strep) to each well (A1, A2, B1 and B2) of Nucleocuvette™ Strip and also to old 

tube number 5. Then add them to each tube as described in step 9 and resuspend 

well. Use the blue micropipette with the yellow button on the plunger which has 

small pipet tips. Now each tube has a total volume of 120 µl. 

11. Mark on the cover of Nucleocuvette™ Strip the used wells. Put this strip in a plastic 

holder/bag and put tape on it to close the package. 

12. Divide the cell suspension of each tube into three wells of 24-well plate according to 

Table 7. Before taking 40 µl of cell suspension for each well on the 24-well plate, 

resuspend the well and after adding to the well, resuspend again in the well.   

 

Table 7: format of 24-well plate to fill in from the five tubes. 

 A B C D E F 

1 PBS Tube 1 Tube 1 Tube 1 Tube 5 PBS 

2 PBS Tube 2 Tube 2 Tube 2 Tube 5 PBS 

3 PBS Tube 3 Tube 3 Tube 3 Tube 5 PBS 

4 PBS Tube 4 Tube 4 Tube 4 PBS PBS 

Tube 5 = LX-2 cells with RPMI with supplements (10% FBS, 1% L-glutamine, and 1% pen/strep) which 

were not in Nucleofector® (condition nr. 5). 

13. Check the wells whether the cells are present in the 24-well plate under a 

microscope. 

14. Swirl the 24-well plate in the form of ‘8’ to divide the cells well over the wells. 

15. Use Parafilm tape around the 24-well plate to close it. 

16. Put the 24-well plate and nucleofection strip in a cell transport box. Also, put 

Nucleofector® Solution and the working solution of the pmaxGFP™ vector on ice in 

the container. 

17. Transport the container with ice and the cell transport box to the ML-II lab of PDT. 

 

5. Post Nucleofection® 
1. Incubate the 24-wells plate with LX-2 cells in humidified 37oC/ 5% CO2 incubator until 

analysis. Gene expression or down-regulation, respectively, is often detectable after only 

4-8 hours. A usual analysis time is 24 hours post-Nucleofection™. 

2. Put Nucleofector® Solution and working solution of pmaxGFP™ vector in Lonza box into 

the fridge of ML-II. 

3. Store the Nucleocuvette™ Strip in the ML-II lab at room temperature. 

4. Replace the culture medium of the wells after 24 hours and then two times a week. 
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Analysis 
24 hours after Nucleofection™ the 24-well plate will be assessed by an inverted fluorescence 

microscope Nikon Ti-E. 

The pmaxGFP™ protein has a wavelength excitation at 482 nm and emission at 502 nm. So to be able 

to see fluorescent signals of GFP, a filter block with the name FITC will be used. To search for cells the 

block ‘RFLTC’ will be used with a lamp. 

When assessing the cells under a microscope, the green fluorescent signals are expected to be visible 

in the cytoplasm of cells when there is an expression of the gene pmaxGFP™ from the vector. This is 

an indication that the pmaxGFP™ vector has been successfully transfected into this cell by 

Nucleofector®. 

 

Table 8: Format of 24-well plate with conditions  

 A B C D E F 

1 PBS A1.1 A1.2 A1.3 Tube 5.1 PBS 

2 PBS B1.1 B1.2 B1.3 Tube 5.2 PBS 

3 PBS A2.1 A2.2 A2.3 Tube 5.3 PBS 

4 PBS B2.1 B2.2 B2.3 PBS PBS 

Conditions of wells:  

A1.1 – A1.3 = with pmaxGFP™, pulse code: EW-113 

B1.1 – B1.3 = without pmaxGFP™ vector, pulse code: EW-113 

A2.1 – A2.3 = with pmaxGFP™ vector, pulse code: CA-137 

B2.1 – B2.3 = without pmaxGFP™ vector, pulse code: CA-137 

Tube 5 = without pmaxGFP™ vector and no Nucleofection®. 

 

Protocol for analyzing 24-well plate by Nikon Ti-E microscope: 
1. Take the 24-well plate from the incubator of ML-II lab and check the wells with LX-2 

cells under Fisher Scientific Microscope (S/N: 2606-2710-029) at an objective 

magnification of 4x. 

2. Take Parafilm tape to tape the edge of the lid of the 24-well plate closed. 

3. Transport the 24-well plate with one glove, through the labs to the lab with inverted 

microscope Nikon Ti-E. 

4. Insert the 24-well plate into a holder specific to this plate at Nikon Ti-E. Be sure that 

the holder is inserted correctly on the microscope table. To avoid hills. 

5. Start the computer to which the Nikon Ti-E is connected. 

6. Start the ‘Power Manager’ software right under of screen and click on the image with 

the name ‘Christian’. Then digitally switch on all the power points of the microscope. 

7. Start the software named ‘Hokawo’. Click on the video camera icon to start ‘Live 

image acquisition’. Click on the icon of the graph to get ‘Display LUT’ (LUT = Look Up 

Table). Here the intensity of the light signal is displayed. Important to check the first 

beam, it must be around green to have balanced light intensity to not lose the 

difference in signals (contrast). 

8. Also start the software named ‘LLE SOLA-SE2’ (Lumencor) to use it for measuring 

fluorescence signals. 
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9. On the microscope, click on the button of ‘L100’ at the front of the microscope to let 

the light through to the camera which has the highest resolution in color black and 

white. The image will be shown on the screen of the computer.  

10. Check on the front of the microscope that ‘Intermediate Magnification Knob’ is set on 

1X. 

11. On the right side of the microscope, switch on the ‘RFLTC’ mode by pressing on 

button ‘FL Block’. On the left side of the microscope, press the button ‘Obj’ to change 

from objective to objective with a magnification of 4X (see the screen in front of the 

microscope). Then on the left side of the microscope, switch on the lamp by pressing 

the button ‘ON/OFF’ and adapt the intensity of the lamp with the scroll button until 

the ‘Display LUT’ first bar is getting around green. 

12. Move the 24-well plate by using the joystick on the right of the microscope on the 

table until you are at the right well to start analyzing the LX-2 cells. Use the button on 

the joystick to adapt the speed of movement of the microscope table. Use the big 

scroll button to change focus and find the cells. To adapt the speed of changing focus, 

press one of the buttons: ‘Coarse’, ‘Fine’ or ‘Extra Fine’.  

Please write down the distance between the objective and the well in your lab 

journal to find the cells back. The distance is displayed on the digital screen in front 

of the microscope.  

13. When you find the cells at the right focus while looking at the live image on the 

computer, then click on the same icon of the video camera to stop the live image. 

Switch off the lamp of the microscope by pressing the button on the left side of the 

microscope. 

14. Click on ‘File’ → ‘Save as’ (NOT on ‘Save Display’ !) and save the image as the 

following example of name: A1.1_4x_BF_1 

A1.1 means the well number 1 of condition A1. So third well of A1 condition = A1.3 

See Table 8 for an overview of the 24-well plate. 

4x → magnification of objective used to create this image. 

BF → filter block, BF (Bright Field) is the block ‘RFLTC’. For fluorescence signals of GFP, 

the filter block ‘FITC’ will be used and written down instead of ‘BF’.  

_1 → is the number of images of the same well with the same filter block. The 

second location on the same well with the same filter block will be written as ‘_2’ 

Save it as type ‘TIF’. 

15. After saving this image, change the filter block to ‘FITC’ by pressing on button on the 

right side of the microscope. On the digital screen, ‘FITC’ will be shown. 

16. Switch on the light for fluorescence digitally with the software Lumencor. For the first 

time, check the signal with ‘Display LUT’ to see whether the first beam is around 

green. Adapt the exposure time at the software Lumencor to change the signal 

intensity. After choosing the best exposure time, leave it at the same time for the rest 

of the experiment. 

17. Stop the live image by clicking on the video camera icon. Switch off the fluorescence 

light through Lumencor software. 

18. Save the image as, for example: A1.1_4x_FITC_1 

19. Now change the filter block to ‘RFLTC’ and switch the lamp on by pressing the button 

on the left side of the microscope. 

20. Search for a new location by moving the 24-well plate with the joystick and do the 

steps from 12-18. When you have made images of all wells (see Table 8) and saved 

them, go to step 20. 
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21. Do steps 11 until 19 again with another objective magnification if necessary. 

22. When finished with making all images of the wells, use a new glove to transport the 

24-well plate back to the ML-II lab.  

23. When arriving in the lab, first clean the 24-well plate with 70% ethanol. Leave it for a 

minute to damp out the 70% ethanol. 

24. Pull the Parafilm tape off from the 24-well plate and put it in 37oC/ 5% CO2 incubator. 

 

Protocol to create composites with software ‘ImageJ’ 
1. Start the software ‘ImageJ’ on the Windows computer. 

2. Open the ‘explorer’ folder on the Windows computer and search for the folder with 

images from analysis with the Nikon Ti-E microscope. 

3. Choose the images with ‘BF’ and ‘FITC’ for the same well and location, and move 

them to program ‘ImageJ’. 

The two names of the two images look like this: 

A1.1_4x_BF_1 

A1.1_4x_FITC_1 

4. Now click on as following: Image → Color → Merge channels. 

5. Now set the colors on the right image. In this case, choose green for the image with 

‘FITC’ and gray for the image with ‘BF’. Click ‘OK’ 

6. Now a composite is made of both chosen pictures. Click on the following buttons: 

Image → Type → RGB color → File → Save as → Tiff 

Call this as, for example: A1.1_4x_composite_1. 

7. Repeat steps 3 to 6 until finished with the creation of composites of all images. 

 

7.4 Protocol: Calculation of confluence of cells with ImageJ 
 

Protocol to calculate the confluence of cells on the image with ImageJ 

1. Start software ‘ImageJ’ 

2. Start ‘Explorer’ and go to the map with images to calculate confluence. 

3. Select the image to calculate the confluence of cells and move it to ‘ImageJ’ 

4. Select ‘Image’ → ‘Type’ → ‘8-bit’ to convert the image into 8-bit image. See Figure 10 for an 

overview of buttons from ImageJ. 

Figure 10: ImageJ program overview of buttons  

5. Now click on the following buttons: ‘Process’ → ‘Filters’ → ‘Variance’ 

6. Set ‘Preview’ on and find out which variance radius is suitable to mark the cell membrane of 

most of the cells. Choose a variance radius of 3 pixels in this case. 

See Figure 11 
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Figure 11: Left is the original bright field image of cells. Right is the same image of cells but after using a variance filter with 
a radius of 3 pixels.  

7. Click on the following buttons: ‘Image’ → ‘Adjust’ → ‘Threshold’ 

8. See Figure 12 for an example of adjustment of Threshold with the Otsu algorithm and black & 

white (B&W) contrast and switch on ‘Dark background’. Set the upper slider to ‘25’ as the 

minimum threshold value and the lower slider to ‘255’ as the maximum threshold value, see 

Figure 12. Then click on ‘Apply’. 

 

 

Figure 12: Threshold values adjusted with Otsu algorithm with black & white (B&W) contrast with dark 
background.  

9. Now click on the following buttons: ‘Process’ → ‘Binary’ → ‘Fill Holes’ to fill the holes inside 

the white circles. 
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10. Click on the following buttons: ‘Analyze’ → ‘Analyze Particles’ and set the Size to a minimum 

of 50 pixels2 to analyze most of the cells. See Figure 13 for used settings. In this case, the 

calculated ‘% Area’ from ImageJ, is the confluence in percentage. The total area in pixels of 

the example image is 2048 pixels x 2048 pixels = 4194304. For example: the total area of 

particles was 374999 pixels. After calculating the confluence with Equation 2, it is indeed the 

same value as ‘% Area’ which is calculated by ImageJ ‘Analyze Particles’. 

Equation 2 

𝐶𝑜𝑛𝑓𝑙𝑢𝑒𝑛𝑐𝑒 [%] = (
𝑎𝑟𝑒𝑎 𝑜𝑓 𝑝𝑎𝑟𝑡𝑖𝑐𝑙𝑒𝑠 [𝑝𝑖𝑥𝑒𝑙𝑠]

𝑡𝑜𝑡𝑎𝑙 𝑎𝑟𝑒𝑎 𝑜𝑓 𝑖𝑚𝑎𝑔𝑒 [𝑝𝑖𝑥𝑒𝑙𝑠]
) ∗ 100 

 

Figure 13: ‘Analyze Particles’ settings to calculate the percentage of area by ImageJ.  

7.5 Protocol: Alamar Blue assay 
Alamar Blue assay protocol 

Materials: 

• Culture medium: DMEM + 10% FBS +1% pen/strep + L-Glutamax 

• PBS 

• Alamar Blue 

• Black-bottom 96-well plate 

Protocol: 

1. Preheat LX-2 medium + PBS a half hour before 

2. Turn off the light in the LAF cabinet (Alamar Blue is light-sensitive!) 

3. Prepare Alamar Blue (AB) medium: 10% Alamar Blue with culture medium 

a. 5 conditions + 1 control + 1 extra → 350 µl Alamar Blue + 3150 (5*630) µl culture 

medium → total 3500 µl AB medium 

b. Mix well 

4. Wash wells 1x with 250 µl PBS per well: a total of 1500 µl PBS is needed. 

Table 9: Format of 24-well plate with conditions 

 A B C D E F 

1 Empty A1.1 A1.2 A1.3 Tube 5.1 Control AB 

2 Empty A2.1 A2.2 A2.3 Tube 5.2 Empty 

3 Empty B1.1 B1.2 B1.3 Tube 5.3 Empty 

4 Empty B2.1 B2.2 B2.3 Empty Empty 

The green-marked wells will be used for Alamar Blue.  
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5. Add 500 µl 10% AB medium per well + add 500 µl AB medium in an empty well (without 

cells). See Table 9 for an overview. 

Please note the time. 

6. Put the plate in the incubator – check every hour shortly if the color has changed 

7. When the color of one of the wells is bright pink (compared to the control without cells) 

transfer 2*150 µl in two different wells in a black-bottom 96-well plate (see Table 10) 

Table 10: Format of a 96-well plate (only rows A to B are shown here).  

 1 2 3 4 5 6 7 8 9 10 11 12 

A A1 A1 A2 A2 B1 B1 B2 B2 T5 T5 CONTROL AB CONTROL AB 

B             

 

a. Color change is expected in 4-6 hours 

b. Quickly check in the incubator, no need to take the whole out every time 

c. Turn the light off in the LAF cabinet while transferring the medium 

d. Use reverse pipetting mode to prevent the formation of bubbles 

8. Wrap the plate in foil, and take it to the plate reader with one hand with the glove on 

a. Plate reader is located in the storage area, next to the LAF cabinet 

b. Switch on the computer and switch on the Perkin Elmer Victor X3 plate reader. The 

lamp of the plate reader will be green. 

9. Measure the plating using the AB assay protocol 

a. Insert the plate without the lid on 

b. Press on the green arrow button 

c. Select the Alamar Blue protocol (called ‘protocol goed’) 

d. Choose the selected wells, which will be marked blue (see Table 10 for an overview) 

e. Name the plate using the date, cell line, and your name in Notes of program 

f. After running, click on the ‘Latest assay result’ button. 

g. Then click the following: File → Export → map of your choice → save it in the map 

with the date and name of cells and experiment on the computer.  

h. Save the file on a USB stick (no internet connection available) 

10. Calculate the amount of metabolic activity 

a. Calculate the average of each condition 

b. Subtract the control value 

c. Normalize all samples against your control → put the control on 100% 
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7.6 LX-2 cells with GFP after 168h of Nucleofection® 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Condition 168h: BF image 1 168h: BF image 2 

EW-113 
GFP 

  
CA-137 
GFP 

  
Figure 14: Brightfield images of LX-2 cells with GFP 168 hours after Nucleofection® with programs EW-113 and CA-137 are 
shown. Two images of each program are taken at different locations of the same well. The images were taken at a 
magnification of 4x. 


